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Please find enclosed our manuscript “Preparation of biological samples through high-
pressure freezing, microwave-assisted processing and minimal resin embedding for FIB-
SEM” prepared as invited submission to JoVE. 
 
Since life science has seen many different advances in the realm of acquiring and analyzing 
samples in 3D the methods of sample preparation have become very important. Depending 
on the scientific question and the structure of interest different methods can be applied to 
prepare samples for electron microscopy. 
 
For best sample preservation and best contrast we have combined different important 
techniques: High-pressure freezing is providing structural preservation close to the native 
state, while chemical fixation and contrast enhancement by a series of heavy metal 
impregnations is the best method to obtain excellent contrast for 3D imaging in the scanning 
electron microscope. By combining cryo-immobilization, freeze-substitution, followed by 
microwave-assisted post-staining for contrast enhancement, we manage to combine the best 
of both techniques. In the last preparation sample step the use of minimal resin embedding 
allows direct and faster targeting inside the FIB-SEM and reduces the time spend on 
exposing the region of interest. 
In our manuscript we describe in detail the necessary preparative steps to provide a helpful 
resource for researchers working with 3D electron microscopy (FIB-SEM, SBEM and array 
tomography). 
 
Thank you for handling our manuscript and I am looking forward to your response. 
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(Dr. Wiebke Möbius)  
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SUMMARY:  25 
Here we present a protocol for combining two sample processing techniques, high-pressure 26 
freezing and microwave-assisted sample processing, followed by minimal resin embedding for 27 
acquiring data with a focused ion beam scanning electron microscope (FIB-SEM). This is 28 
demonstrated using a mouse tibial nerve sample and Caenorhabditis elegans. 29 
 30 
ABSTRACT:  31 
The described sample preparation technique is designed to combine the best quality of 32 
ultrastructural preservation with the most suitable contrast for the imaging modality in a focused 33 
ion beam scanning electron microscope (FIB-SEM), which is used to obtain stacks of sequential 34 
images for 3D reconstruction and modelling. High-pressure freezing (HPF) allows close to native 35 
structural preservation, but the subsequent freeze substitution often does not provide sufficient 36 
contrast, especially for a bigger specimen, which is needed for high-quality imaging in the SEM 37 
required for 3D reconstruction. Therefore, in this protocol, after the freeze substitution, 38 
additional contrasting steps are carried out at room temperature. Although these steps are 39 
performed in a microwave, it is also possible to follow traditional bench processing, which 40 
requires longer incubation times. The subsequent embedding in minimal amounts of resin allows 41 
for faster and more precise targeting and preparation inside the FIB-SEM. This protocol is 42 
especially useful for samples that require preparation by high-pressure freezing for a reliable 43 
ultrastructural preservation but do not gain enough contrast during the freeze substitution for 44 
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volume imaging using FIB-SEM. In combination with the minimal resin embedding, this protocol 45 
provides an efficient workflow for the acquisition of high-quality volume data.  46 
 47 
INTRODUCTION:  48 
High-pressure freezing is the sample preparation method of choice for obtaining high-quality 49 
ultrastructural preservation, which represents the native state of a sample much better than 50 
conventional preparation methods using chemical fixation1. This cryo-preparation method is 51 
useful for samples such as myelinated mouse tissue2 and a strict requirement for use of the model 52 
organism Caenorhabditis elegans3. After freeze substitution and resin embedding, these samples 53 
are usually analyzed by transmission electron microscopy (TEM) or electron tomography (ET). If 54 
bigger volumes must be imaged using FIB-SEM or serial block-face imaging for high-resolution 55 
large-scale 3D reconstructions, in our experience proper imaging by SEM is often hampered by 56 
the lack of contrast. In the FIB-SEM, the image is usually recorded by the detection of 57 
backscattered electrons from the primary electron beam. The yield of backscattered electrons is 58 
proportional to the content of heavy metals in the sample. Therefore, protocols were especially 59 
designed for volume imaging to enhance the contrast by additional heavy metal impregnation. 60 
Such methods are based on chemically fixed samples and apply a combination of osmium 61 
tetroxide-thiocarbohydrazide-osmium tetroxide4, as described by Knott et al.5, for serial block-62 
face and focused ion beam scanning electron microscopy. Modifications including the use of 63 
formamide and pyrogallol6 or lead aspartate7 have been successfully applied for different imaging 64 
techniques. 65 
 66 
The protocol provided here combines the cryo-preparation of specimens by HPF and freeze 67 
substitution with subsequent microwave-assisted processing for enhanced contrast using 68 
thiocarbohydrazide/osmium tetroxide in acetone at room temperature. We demonstrate this on 69 
the myelinated nervus tibialis of mice and in Caenorhabditis elegans, which represent samples 70 
that require high-pressure freezing for high-quality ultrastructural preservation. In addition, it is 71 
shown how, after dehydration and infiltration, the samples are embedded with as little resin as 72 
possible. This minimal resin embedding8 allows for faster targeting of the structure of interest 73 
and reduces the time spent on sample processing, including less time required for exposing the 74 
region of interest with the ion beam. After performing further sample preparation steps inside 75 
the microscope, imaging and milling of the sample is carried out continuously to acquire a stack 76 
of images. For 3D visualization, image processing software (IMOD) is used to reconstruct parts of 77 
the dataset. 78 
 79 
Our workflow describes how the most suitable contrasting of samples for volume imaging can be 80 
combined with the best ultrastructural preservation by HPF and freeze substitution. This is useful 81 
for samples that strictly require cryo-preparation. Applications are limited to small samples that 82 
can be prepared by HPF. In samples of different nature, such as plant material or microorganisms, 83 
this protocol requires adaptation.  84 
 85 
PROTOCOL:  86 
 87 
All experiments including samples from animals described here have been approved by the 88 
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Institutional Animal Care and the Lower Saxony State Office for Customer Protection and Food 89 
Safety (LAVES). 90 
 91 
1. High-pressure freezing and freeze substitution 92 
 93 
1.1 Dissect the nervus tibialis from a mouse (e.g., C57Bl6N, 12 weeks, female)9. 94 
 95 
1.2 Immerse the nervus tibialis in a droplet of 20% polyvinylpyrrolidone (1 g of PVP in 5 mL) 96 
in phosphate buffered saline (PBS) and cut pieces of 2 mm length. Then, place it in a metal sample 97 
carrier (Type A, 0.2 mm depth) using fine forceps. Add another flat carrier (Type B) coated with a 98 
thin layer of hexadecane as a lid and insert this assembly into the specimen cartridge.  99 
 100 
1.3 Transfer several C. elegans suspended in a droplet of 20% bovine serum albumin (BSA) in 101 
M9 (see Table of Materials) with a disposable plastic pipette into the metal carrier (Type A). 102 
Then, add a second carrier as lid on top (Type B) and assemble the cartridge. 103 
 104 
1.4 For both of the samples, proceed with the following: high-pressure freeze the sample 105 
carrier assemblies one-by-one by loading them into the three-piece cartridge in the loading 106 
station of the high-pressure freezer. Press the process button according to the manufacturer’s 107 
operating instructions.  108 
 109 
NOTE: Both types of samples can be processed together in the subsequent freeze substitution. 110 
 111 
1.5 Place the samples into cryovials containing 2 mL of frozen 0.1% tannic acid in acetone. 112 
Perform the transfer in a bath of liquid nitrogen without spilling liquid nitrogen into the vials. 113 
Transfer the cryovials into an automatic freeze substitution unit10 set at -90 °C and start the 114 
program.  115 
 116 
NOTE: The samples are kept at -90 °C for 100 h. Tannic acid before osmification is used as 117 
mordant to increase the uptake of osmium tetroxide11. 118 
 119 
1.6 Manually wash the samples 3x for 30 min with 2 mL of acetone at -90 °C in the freeze 120 
substitution unit. 121 
 122 
1.7 Leave the samples in 2 mL of 2% osmium tetroxide, 0.1% uranyl acetate in acetone for 123 
continued staining in the automatic freeze substitution unit for 7 h at -90 °C. 124 
 125 
CAUTION: Osmium tetroxide is toxic and should be handled under a fume hood, and protective 126 
equipment should be worn. 127 
 128 
NOTE: The freeze substitution unit automatically raises the temperature to -20 °C at 5 °C/h. The 129 
samples are kept at -20 °C for 16 h in the freeze substitution unit. The temperature will be raised 130 
automatically to 4 °C at 10 °C/h. 131 
 132 
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1.8 Exchange the osmium tetroxide solution with pure acetone when the temperature has 133 
reached 4 °C. Remove the cryovials from the freeze substitution unit.  134 
 135 
2. Microwave-assisted processing 136 
 137 
NOTE: Perform all of the following steps at room temperature12 using a temperature control unit 138 
to keep the temperature stable (see Table of Materials). 139 
 140 
2.1 Leave the caps of the reaction tubes open during processing in the microwave. 141 
 142 
2.2 Take the metal sample carriers out of the cryovials and remove the samples from the metal 143 
carrier using fine forceps or a needle, while keeping the samples submersed in acetone in a watch 144 
glass dish (150 mm).  145 
 146 
2.3 Transfer the samples into 2 mL reaction tubes using fine forceps or a pipette and wash with 147 
1 mL of acetone four times for 40 s at 250 W. 148 
 149 
CAUTION: Thiocarbohydrazide is toxic and should be handled under a fume hood, protective 150 
equipment should be worn. 151 
 152 
2.4 Stain samples with 1 mL of 1% thiocarbohydrazide in acetone for 14 min at 150 W to increase 153 
the contrast. To perform the staining, pipette the thiocarbohydrazide solution into the reaction 154 
tube, place the tube in the microwave, and set the program to a power level of 150 W (with the 155 
vacuum function turned on) for 2 min on/2 min off, iterating for 14 min total. Start the 156 
microwave. 157 
 158 
NOTE: Thiocarbohydrazide reacts with the osmium tetroxide that was applied during the freeze 159 
substitution. It forms a bridge, allowing more osmium tetroxide to be deposited onto the original 160 
osmium tetroxide sites13. 161 
 162 
2.5 Wash the samples 4x with 1 mL of acetone for 40 s at 250 W. Pipette the acetone into a 163 
reaction tube, place the tube into the microwave, and select 250 W for 40 s. Start the microwave. 164 
 165 
2.6 Stain in 1 mL of 2% osmium tetroxide in acetone for 14 min at 150 W. Pipette the osmium 166 
tetroxide solution into a reaction tube, place the tube into the microwave, and set the program 167 
to a power level of 150 W (with the vacuum function turned on) for 2 min on/2 min off, iterating 168 
for 14 min total. Start the microwave. 169 
 170 
2.7 Wash the samples 4x with 1 mL of acetone for 40 s at 250 W (as done in step 2.5).  171 
 172 
2.8 Infiltrate with 1 mL increasing concentrations of resin in acetone (see Table of Materials) of 173 
25%, 50%, 75%, 90%, 100%, and 100% for 3 min each at 250 W. Pipette the resin into a reaction 174 
tube, place the tube into the microwave, and set the program to a power level of 250 W (with 175 
the vacuum function turned on) for 3 min. Start the microwave.  176 
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 177 
3. Minimal resin embedding8 178 
 179 
3.1 Take the nervus tibialis and C. elegans out of the reaction tube with a toothpick and place 180 
them on a piece of plastic film (see Table of Materials). 181 
 182 
3.2 Use the toothpick to gently push the sample around on the plastic film until no remaining 183 
resin is detected. Use a halogen lamp for heating (see Table of Materials) so the resin becomes 184 
less viscous and is able to be removed more easily. Place the halogen lamp close enough to heat 185 
up the resin (being careful not to burn hands). 186 
 187 
3.3 Polymerize the samples for at least 48 h at 60 °C on top of the plastic film in the oven. 188 
 189 
4. Preparation for FIB-SEM 190 
 191 
4.1 Cut out the polymerized samples together with the plastic film using a razor blade at a size 192 
fitting the SEM stub and attach them to the SEM stubs using a conductive silver resin (see Table 193 
of Materials). Polymerize again at 60 °C for at least 4 h or overnight. 194 
 195 
4.2 Sputter coat the samples on the SEM stub with gold for 1 min at 35 mA using a sputter coater 196 
(platinum/palladium can also be used; a 10 nm thick coating is sufficient) and place them inside 197 
the FIB-SEM. 198 
 199 
5. Data acquisition inside the FIB-SEM 200 
 201 
5.1 Image the samples with the secondary electron detector using the basic software driving the 202 
microscope (see Table of Materials). The sample should be oriented so that the region of interest 203 
(e.g., middle part of the nervus tibialis or the C. elegans) is in the field of view. 204 
 205 
NOTE: To perform the data acquisition, tilt the stage to a position so that the sample faces the 206 
ion beam at a 90° angle at an appropriate working distance (5 mm) in the so-called coincidence 207 
point of the ion and electron beam. Using our instrument, this is achieved at a stage tilt of 54° 208 
and 5 mm working distance. 209 
 210 
5.2 To set up the correct position of the sample, center a common feature at a 0° tilt while 211 
imaging with the secondary electron detector. Slowly tilt to 54° (5°, 20°, 54°), recentering the 212 
same object by moving the M-axis. 213 
 214 
5.3 Find the coincidence point by centering a feature while imaging with the secondary electron 215 
detector at 54°, followed by moving the feature to the central position in the FIB mode. Perform 216 
this by displaying the crosshairs in the SEM software to have an indication of the center. Then 217 
first move the selected sample feature to the center of the image area by using the center point 218 
function of the SEM software. Then center the feature along the y-axis by moving the stage in z. 219 
Any final offset between FIB and SEM is corrected with the SEM beam shift. 220 
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 221 
5.4 Open the advanced software (see Table of Materials) for recording 3D datasets and follow 222 
the software wizard step-by-step.   223 
 224 
5.5 At the region of interest, deposit carbon or platinum (400 nm) on top of the ROI using a 3 nA 225 
current to allow even milling and reduce artifacts induced by charging.  226 
 227 
NOTE: By drawing the region of interest to be milled on the specimen surface imaged with the 228 
FIB (width, height, depth), the software calculates and superimposes the sizes of the different 229 
sample preparation features, such as the trenches to be milled or area for platinum/carbon 230 
deposition. Also, be cautious of imaging the sample surface with too-high FIB currents, as this 231 
can damage the sample surface. A current of 50 pA is sufficient for imaging. 232 
 233 
5.6 Use the focused ion beam to mill a trench to expose the region of interest (ROI) using a 15/30 234 
nA current.  235 
 236 
5.7 Use the focused ion beam to polish cross-section with a 7 nA current. 237 
 238 
5.8 After finishing the sample preparation, set up the following imaging parameters: FIB milling 239 
parameters in the FIB setup tab (FIB milling current); SEM imaging parameters in the setup tab 240 
and the image tuning parameters in the SEM AutoTune tab (perform autofocus and 241 
autostigmation every 60 min, 50 nm pixel size, dwell time 3, line average 3). Optimize this for 242 
every sample. 243 
 244 
5.9 To prevent any thermal drift causing the block-face to drift during the run, leave the room for 245 
at least 2 h before starting the acquisition. 246 
 247 
5.10 Acquire the dataset in a continuous mill and acquire mode with a 700 pA FIB current. Use 248 
1.5 kV (analytic mode, 900 V) ESB detector with a grid voltage of 400 V to acquire images each 249 
with 5 nm pixel size using the advanced software (see Table of Materials) and 50 nm slice 250 
thickness. One image acquisition takes about 1.5 min with a dwell time of 6 µs. 251 
 252 
5.11 Start the data acquisition. A FIB image at the milling current is acquired to ensure that the 253 
sample did not move and the right region of interest is selected. Adjust if necessary. 254 
 255 
6. Data visualization 256 
 257 
6.1 Open images in Fiji by dragging the folder containing all the images into Fiji and select Virtual 258 
Stack. 259 
 260 
6.2 Crop the region of interest using the rectangle tool (Image > Crop).  261 
 262 
6.3 Invert the data to show the traditional transmission electron microscopy contrast with 263 
membranes showing up in dark (Edit > Invert). 264 
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 265 
6.4 Use TrackEM214 (Fiji15) for alignment. Load the data into TrackEM2 (File > New > TrackEM2) 266 
by clicking on layer. After all images are loaded, align them using multi-layer mosaic function 267 
(right-click on Image > Align > Align multi-layer mosaic). After alignment, the images are 268 
exported as individual tiff-files (right-click on image > Export > Make flat image). Select all images 269 
that should be exported and choose save to file. 270 
 271 
6.5 For post-processing, use a Gaussian blur (Process > Filters > Gaussian blur; sigma 2) and local 272 
contrast enhancement (Process > Enhance Local Contrast; CLAHE: blocksize 127, histogram bins 273 
256, maximum slope 1.5), which are applied in Fiji to smooth the image and obtain a better signal-274 
to-noise ratio. 275 
 276 
6.6 IMOD16 is used to perform a manual segmentation and visualize the structure of interest in 277 
3D. Open the dataset in IMOD and select Drawing tools (Special > Drawing Tools) to perform the 278 
manual segmentation. Different manual tools can be used to follow the structure of interest 279 
throughout the volume (for example Join, Sculpt). Use Microscopy Image Browser (MIB17) for 280 
semi-automated segmentation. 281 
 282 
REPRESENTATIVE RESULTS:  283 
 284 
The workflow starts with a sample (here, a freshly dissected mouse nervus tibialis) being placed 285 
in metal carriers for high-pressure freezing (Figure 1a). The carriers are recovered from liquid 286 
nitrogen (Figure 1b) and placed in a freeze substitution unit on top of the frozen first chemical 287 
cocktail (Figure 1c). After a long freeze substitution protocol including 2% osmium tetroxide and 288 
0.1% uranyl acetate, the samples are removed from the carriers at room temperature (Figure 289 
1d). To further enhance the contrast, the samples are transferred to plastic tubes to be processed 290 
in the microwave (Figure 1e). The vacuum chamber and temperature control unit are used to 291 
optimize the process (Figure 1f). 292 
 293 
To be able to perform the minimal resin embedding, toothpicks and sheets of plastic film are 294 
needed (Figure 2a). After infiltrating the samples with resin using the microwave, they are placed 295 
on pieces of plastic film and moved around until no resin is left on the sample surface. A halogen 296 
lamp is used to help drain the remaining resin and leave the sample minimally embedded (Figure 297 
2b) on the plastic film. It should be noted that more resin removed from the top of the sample is 298 
good. There should still be a small amount left underneath the sample to keep it attached to the 299 
substrate. The sample being polymerized on the plastic film is cut and mounted on top of SEM 300 
stub with silver conductive resin (Figure 2c). The stub is polymerized for at least 4 h at 60 °C 301 
(Figure 2d). The components should be mixed thoroughly or the mixture may not polymerize 302 
correctly. To avoid charging inside the scanning electron microscope, the stub is sputter coated 303 
with gold or platinum/palladium (Figure 2e).  304 
 305 
The samples are placed in the FIB-SEM and imaged with a secondary electron detector to target 306 
the region of interest (Figure 3a,e). An ion beam is used to remove material directly in front of 307 
the region of interest to expose a cross section (Figure 3b-d, 3f-h). Standard protocols often 308 
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suffer from a lack of membrane contrast (Figure 3b,f), whereas the enhanced protocol provides 309 
a strong membrane contrast (Figure 3c-d, 3g-h).  310 
 311 
The EM data (after post-processing) are visualized using IMOD, an image processing and 312 
modelling program. To achieve a better understanding of the 3D information, virtual reslicing of 313 
the data is used (Figure 4a). Different structures of the dataset are segmented manually (Figure 314 
4b-d). 315 
 316 
FIGURE AND TABLE LEGENDS:  317 
 318 
Figure 1: High-pressure freezing, freeze-substitution, and microwave-assisted processing. (a) 319 
Sample carrier containing the mouse nervus tibialis, scale bar 3 mm. (b) Sample carrier containing 320 
the mouse nervus tibialis after high-pressure freezing, scale bar 3 mm. (c) Automatic freeze 321 
substitution (AFS) unit with samples. Inset: custom-made metal container for up to 23 sample 322 
vials and two large vials containing chemicals in the AFS. (d) Samples being removed from carriers 323 
in a glass dish in acetone, scale bar 3 mm. (e) Samples in reaction tubes to be put in the 324 
microwave for processing. (f) Vacuum chamber and temperature control unit of the microwave. 325 
 326 
Figure 2: Minimal resin embedding and preparation for the FIB-SEM. (a) Plastic film and 327 
toothpicks that are used for the minimal resin embedding, scale bar 4 cm. (b) Nervus tibialis 328 
drained of resin on top of the plastic film, scale bar 250 µm. (c) Nervus tibialis polymerized on 329 
plastic film, then cut and mounted on top of the SEM stub with silver conductive resin, scale bar 330 
250 µm. (d) Samples polymerized on top of the SEM stub, scale bar 3 mm. (e) Samples coated 331 
with gold on the SEM stub, scale bar 3 mm.  332 
 333 
Figure 3: Preparation of the sample inside the FIB-SEM. (a and e) Secondary electron image 334 
inside the FIB-SEM of the sample surface (a) Nervus tibialis, scale bar 100 µm. (e) C. elegans, scale 335 
bar 2 µm. (b-d) and (f-h) Cross-section through sample using ESB detector for imaging. (b and c) 336 
Nervus tibialis, scale bar 2 µm. (f and g) C. elegans, scale bar 1 µm and 200 nm. (b and f) Shown 337 
are the results of high-pressure freezing and freeze substitution without enhancement, whereas 338 
all other images show results of enhanced freeze substitution. (d and h) Detailed image of the 339 
sample using the ESB detector. (d) Nervus tibialis, scale bar 200 nm. (h) C. elegans, scale bar 200 340 
nm. 341 
 342 
Figure 4: Image acquisition and visualization. (a) EM data shown in IMOD with virtually resliced 343 
x/z- and y/z-planes, scale bar 2 µm. (b) Segmented axons on EM data (blue), Remak bundles (red), 344 
myelin sheets (yellow and orange), and mitochondria (turquoise), scale bar 2 µm. (c and d) 3D 345 
model, scale bar 2 µm and 500 nm. 346 
 347 
DISCUSSION:  348 
 349 
The protocol was developed to illustrate the optimal preservation and contrast to perform serial 350 
block-face imaging with a FIB-SEM. Therefore, we chose to apply cryo-immobilization followed 351 
by post-staining using freeze substitution and microwave-assisted processing. Therefore, this 352 
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protocol is limited to samples that are small enough for high-pressure freezing. The size 353 
limitations of 3 to 6 mm in width and thickness of ~200 µm are established by the size of the 354 
sample carrier, which matches the sample size that can be properly frozen with this technique. 355 
This is relevant for the mouse nerve sample, since the sciatic nerve is too large in diameter to fit 356 
into the 0.2 mm carriers that are required to ensure proper freezing. Therefore, careful dissection 357 
of a smaller nerve such as the tibial nerve or other thin nerve such as the femoral nerve is 358 
recommended. Since the myelin sheath is sensitive to stretching, great care must be taken during 359 
dissection of the fresh and viable nerve to avoid handling artifacts. In general, only viable samples 360 
should be used for electron microscopic studies. 361 
 362 
Microwave-assisted processing and minimal resin embedding are designed for speeding up the 363 
preparation and targeting process. The microwave-assisted processing applying a modified OTO 364 
protocol4 is used for room temperature chemical fixation. A household microwave will not yield 365 
the same results, since there is no homogenous distribution of microwaves, its temperature is 366 
not controlled, and there is no vacuum that can be applied. The smaller a sample, the better 367 
penetration of the chemicals; therefore, the best results are achieved by smaller samples. To 368 
avoid damage to the sample by overheating, temperature control and application of the 369 
minimally required microwave power are critical. The microwave-assisted processing steps can 370 
be performed on the bench if there is no microwave available, which will lead to longer 371 
processing times. To directly target structures in the SEM, it is crucial to remove as much resin as 372 
possible from the top of the sample. After recording a dataset, post-processing of the raw data 373 
is necessary to reduce file size and improve the signal-to-noise ratio. Modern volume imaging 374 
techniques produce large amounts of data. Therefore, to perform the data processing in a fast 375 
and sufficient manner, sufficient RAM on the workstation is needed. For alignment operations at 376 
least two times as much RAM as the dataset size is required. 377 
 378 
This protocol has been tested on the nervus tibialis of the mouse as well as in C. elegans. Hall et 379 
al.12 used a similar enhancement step after their freeze substitution on the bench for preparation 380 
of C. elegans. For any other model organism such as the zebrafish, adjustments of the protocol 381 
are likely necessary. One possible modification is to change the composition of the freeze 382 
substitution cocktail, such as by the addition of water that is used for contrast enhancement18. 383 
Moreover, the duration of the freeze substitution has to be adapted to the sample and can be 384 
considerably shortened according to the quick freeze substitution protocol19. One possibility is 385 
the application of agitation for accelerating the freeze substitution process20. After the freeze 386 
substitution, further modifications are possible, such as repeated application of enhancing 387 
chemicals and osmium tetroxide21. During microwave processing, the temperature, incubation 388 
times, and power settings can be varied to optimize results for the respective sample. 389 
 390 
This protocol shows that such an enhancement can be combined with other freeze substitution 391 
protocols and different types of samples as described by Hall12 that are imaged in a FIB-SEM or 392 
by serial block-face scanning electron microscopy. These imaging techniques require enhanced 393 
contrast, which is less important for transmission electron microscopy.  394 
 395 
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Name of Material/ Equipment Company Catalog Number Comments/Description

Instrumentation

Leica HPM100 Leica

Automatic Freeze Substitution Leica
Laboratory microwave with temperature 

control unit Ted Pella

EM ACE600 with gold target Leica

Crossbeam 540 Zeiss

Halogen lamp 12 V/ 20 W Osram

Oven VWR

Freezing

Bovine Serum Albumin Sigma-Aldrich A2153

M9 Homemade According to  C. Elegans- A practical approach I.A.Hope

Hexadecene Sigma-Aldrich 52276

Polyvinylpyrrolidone Sigma-Aldrich P2307

A type carrier Wohlwend GmbH #241

B type carrier Wohlwend GmbH #242

Slit carrier Wohlwend GmbH #446

Plastic Pasteur pipettes VWR 612-1684

Forceps FST 11200-10

Freeze substitution

Acetone science services 10015

Tannic acid Sigma-Aldrich 403040

Osmium tetroxide EMS 19100

Uranyl acetate SPI-Chem 02624-AB

Acetone EMS 10015

Thiocarbohydrazide Sigma-Aldrich 223220

Nunc CryoTubes Sigma-Aldrich V7884-450EA

Watch glass dishes, 150 mm VWR 216-2189H

Eppendorf tubes Eppendorf 0030 120.094

Durcupan resin Sigma-Aldrich 44610

Mounting

SEM stubs Science Services E75200
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Aclar Science Services 50425-10

Toothpicks

filter paper VWR 512-3618

conductive silver resin EMS 12670-EE EPO-TEK EE 129-4

Software

Image acquisition Zeiss SmartSEM

Image acquisition Zeiss Atlas5 A3D

Image processing Open source Fiji http://fiji.sc/#download

Image visualization Open source IMOD http://bio3d.colorado.edu/imod/

http://fiji.sc/#download
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Editorial comments: 
1. The editor has formatted the manuscript to match the journal's style. Please retain the same. 

2. Please address all the specific comments marked in the manuscript. 

 

Our answers: 

We kept the style and addressed all the comments. 

 

3. For the protocol section, please use imperative tense as if you are directing someone how to 

do your experiment with all specific details. 
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5. Please do not have paragraphs but make substeps instead. 
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link to the editorial policy that allows re-prints. Please upload this information as a .doc or 

.docx file to your Editorial Manager account. The Figure must be cited appropriately in the 

Figure Legend, i.e. “This figure has been modified from [citation].” 

 

Our answer: We did not reuse any figures from published work. 
 


